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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

ANY SOFTWARE ITEM IDENTIFIED AS THIRD PARTY LIBRARY IS AVAILABLE UNDER
SEPARATE SOFTWARE LICENSE TERMS AND IS NOT PART OF A TIBCO PRODUCT. AS SUCH,
THESE SOFTWARE ITEMS ARE NOT COVERED BY THE TERMS OF YOUR AGREEMENT WITH
TIBCO, INCLUDING ANY TERMS CONCERNING SUPPORT, MAINTENANCE, WARRANTIES,
AND INDEMNITIES. DOWNLOAD AND USE OF THESE ITEMS IS SOLELY AT YOUR OWN
DISCRETION AND SUBJECT TO THE LICENSE TERMS APPLICABLE TO THEM. BY PROCEEDING
TO DOWNLOAD, INSTALL OR USE ANY OF THESE ITEMS, YOU ACKNOWLEDGE THE
FOREGOING DISTINCTIONS BETWEEN THESE ITEMS AND TIBCO PRODUCTS.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO Spotfire, TIBCO Spotfire Analyst, TIBCO Spotfire
Automation Services, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Enterprise Runtime
for R, TIBCO Enterprise Runtime for R - Server Edition, TERR, TERR Server Edition, and TIBCO
Spotfire Statistics Services are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. Please see the readme.txt file for
the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2019. TIBCO Software Inc. All Rights Reserved.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any other
documentation included with the product. To access the latest documentation, visit https://
docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO Spotfire Analyst and related products is available on the Spotfire Analyst
Product Documentation page.

● TIBCO Spotfire® Analyst User's Guide

● TIBCO Spotfire® Administration Manager User's Guide

● Working with Cubes in TIBCO Spotfire®

● TIBCO Spotfire® License Agreement

Related documentation is also found on the Spotfire Server Product Documentation page.

Release Version Support

Some release versions of TIBCO Spotfire products are designated as long-term support (LTS) versions.
LTS versions are typically supported for up to 36 months from release. Defect corrections will typically
be delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See
also https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

● For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit http://spotfi.re/sr.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.

For quick access to TIBCO Spotfire content, see https://community.tibco.com/products/spotfire.

5

TIBCO Spotfire® Analyst Release Notes

https://docs.tibco.com
https://docs.tibco.com
https://docs.tibco.com/products/tibco-spotfire-analyst
https://docs.tibco.com/products/tibco-spotfire-analyst
https://docs.tibco.com/products/tibco-spotfire-server
https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm
http://www.tibco.com/services/support
https://support.tibco.com
https://support.tibco.com
http://spotfi.re/sr
https://ideas.tibco.com/
https://community.tibco.com
https://community.tibco.com/products/spotfire


New Features

The following new features have been added to version 10.3 of TIBCO Spotfire® Analyst.

For details about new Spotfire features, see What's New in TIBCO Spotfire in the TIBCO Community.

Updated trust mechanism, including trust for data functions

The trust mechanism for JavaScript and IronPython scripts, and also for data connection custom
queries, has been improved by introducing SHA-512 for calculating the trust stamp. In addition, the
trust mechanism now also applies to data functions and TERR expression functions.

The updated trust functionality means that there are a few additional steps required during the
upgrade to Spotfire 10.3, to make everything work as before. The exact steps to take will depend on
your use case and environment – some examples are described in this article: https://
community.tibco.com/wiki/script-and-data-function-trust-spotfire-103-and-later

Updated notifications

The notifications framework has been updated to allow pop-up notifications and sometimes include
links to where you can fix issues.

The pop-up notifications can be switched off by clicking the Notifications icon on the menu bar and
clearing the check box in the lower part of the flyout.

Reload data improvements
The stability of the data reloading functionality has been improved, in particular for complicated
configurations. The API to reload data tables in an analysis has also been redesigned.

Edit and remove calculated columns from the data canvas

It is now possible to edit and remove top-level entities such as calculated columns, binned columns
and group-from-marked columns directly from the data canvas.

You can also remove predicted columns, result columns from other types of calculations, custom
hierarchies, tags and mask columns in the data canvas.

Custom display names for Spotfire servers

The Spotfire server now supports custom display names as an alternative to the URL to the server.
This makes it easier for users to find the server they should connect to.

Specifying the display name can be done both on the Spotfire Server by setting a display name for a
Site and also on a per-user basis in the Manage Servers page in the login dialog. A display name set in
Manage Servers will override any display name defined on the Spotfire Server.

Improvements when browsing the library

● It is now possible to widen the content browser (the Files and data flyout) by dragging with the
mouse, in order to see really long names.

● The tooltip when hovering over a Spotfire Analysis now includes the description, if any is
available.

● It is now possible to sort the library contents according to the last modified date.

● Performance improvements - browsing the library is now faster.

Snowflake data connector
You can now access data from your Snowflake data warehouse, with the new data connector for
Snowflake.

Native support for MemSQL, MariaDB, and MongoDB Connector for BI
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You can now use the connector for Oracle MySQL to access data from MariaDB, MemSQL, and
MongoDB Connector for BI.

TIBCO Cloud™ Live Apps data connector
You can now connect to and analyze your Live Apps case data in Spotfire, with the new data
connector for TIBCO Cloud™ Live Apps.

Native support for PostgreSQL 11
You can now access data from PostgreSQL 11 with the data connector for PostgreSQL.

Geocoding coverage update

The following data has been updated:

● Over 4,000 new internal administrative boundaries (Admin 1, States, Provinces, Regions…) are
now available worldwide.

● French region names are updated to the latest naming scheme.

Hide geocoding warnings
You can now hide geocoding table warnings that appear in the map chart title.

Layers control state
Whether the map chart layers control is expanded or collapsed, its state is now saved in the analysis.
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Changes in Functionality

The following are changes in functionality in version 10.3 of TIBCO Spotfire® Analyst.

10.3.3

Changes to preference AllowSharingOfCachedDataBetweenUsers

The default value of the preference AllowSharingOfCachedDataBetweenUsers is now False. The
data caching behavior for users in groups with the preference set to False is also changed.

As a user in a group that has the preference AllowSharingOfCachedDataBetweenUsers set to False,
you now cannot use shared cached data in data connections where the option Share cached data
between all concurrent users of the Spotfire web client is selected. You also cannot use shared
queries for database users with different credentials in streaming connections where the option Also
between users with different database credentials is selected.

Unless you have explicitly set the value of the preference to True, the value is changed to False for all
user groups. In some cases, this might affect performance. To edit preferences for user groups, select
Tools > Spotfire Administration Manager.

Changes to connector for Microsoft SQL Server Analysis Services

When you use the connector for Microsoft SQL Server Analysis Services, you can only use the
authentication method Username and password in connections over HTTP.

In earlier versions, it was possible to select Username and password authenticaiton in non-HTTP
connections, but the credentials you entered were not used. The username and password credentials
were ignored, and the authentication method defaulted to Windows authentication.

You can no longer create a non-HTTP Microsoft SQL Server Analysis Services connection and select
Username and password authentication. If you have existing data connections configured this way,
you must edit the connection data sources and change the authentication method to Windows
authentication.

10.3.2

Trust check flow performance improvements

● The trust check flow has been optimized to make the cheapest checks first. This can make saving
DXP files from the library faster, when the files contain scripts.

● An extra cache has been added when checking trust stamps for current users to improve
performance.

10.3.0

MySQL driver changed from .NET to ODBC

The driver required to be able to use the Oracle MySQL data connector to connect to Oracle MySQL
databases has changed. This now requires that you have installed the driver Oracle MySQL
Connector/ODBC, instead of Oracle MySQL Connector/NET.

To be able to continue to use the Oracle MySQL connector and any analyses with existing connections
to Oracle MySQL, you must install the new driver on all computers running Spotfire clients.

Additionally, the Oracle MySQL connector now also supports ODBC drivers for MariaDB and
MongoDB Connector for BI. For details about what drivers to use, see the system requirements for
connectors in Spotfire .

Application Profiler change

8

TIBCO Spotfire® Analyst Release Notes

http://spotfi.re/sr/connectors
http://spotfi.re/sr/connectors


The API call for rendering visualizations that was used in the previous LTS release (7.11) was made
obsolete in 7.12, by the introduction of Visual.RenderAsync. Spotfire 10.3 LTS uses the new API call by
default, for newly created Application Profiler configurations.
When opening an older Application Profiler configuration file, the obsolete type of rendering will be
used, for minimal impact.
The obsolete rendering API can also be used for new configuration files, if necessary, by manually
selecting the check box to render using the pre-7.12 API in the Application Profiler.
However, it is recommended to not use the obsolete rendering API, as it will diverge more and more
over time from what the real visualizations look like, and the functionality may even be removed
completely at some point in the future.

Script management change
The Scripts tab has been removed from the Documentation Properties dialog. Scripts are now instead
managed from the new dialog found under File > Manage trust and scripts.
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Deprecated and Removed Features

The following feature is deprecated or removed as of version 10.3 of TIBCO Spotfire® Analyst.

Affected component Description

Export to PowerPoint The functionality for exporting to PowerPoint as editable objects is
deprecated.
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Installation

The following are instructions on how to install version 10.3 of TIBCO Spotfire® Analyst.

The TIBCO Spotfire® Analyst client is delivered as two different installers. The installer labelled
"single_user" is the default one. Use this if you do not know which version to select. The installer
labelled "single_user" installs the product for the logged in user only. The other users on the same
machine will not be able to use the client. The installer labelled "shared_computer" installs the product
for all users on the machine. This installer requires administrative privileges on the machine.

Installation of Release 10.3

1. First install/upgrade the TIBCO Spotfire® Server to version 10.3.

2. Deploy the TIBCO Spotfire® 10.3 distribution on the TIBCO Spotfire® Server 10.3.

3. Finally, install TIBCO Spotfire® Analyst 10.3 on all client computers.

Installation Notes

● If the .NET 4.5 framework is not installed, it will be downloaded and installed when launching the
"shared_computer" TIBCO Spotfire® Analyst client installer. The "single_user" installer will not
download the .NET framework, because it does not have system changing privileges. However, it
will complain if the .NET framework is missing.

● If the product localization is defined as a user group preference, a client restart is required after the
initial login to the server for the changes to be fully applied. Note that clients are not informed that
such a restart is required. It is also important that the appropriate localization packages are
deployed to the TIBCO Spotfire® Server prior to setting the user group preference.

Note that the correct Language pack and the matching server preference must be set on the very
first server that the user connects to. Changing the settings on the Server will not have any effect. If
the localization group preference does not have any effect, it can be enforced on clients using Tools
> Options.
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Migration and Compatibility

The following are instructions on how to migrate from a previous release to version 10.3 of TIBCO
Spotfire® Analyst.

Upgrading from Previous Version without Installing

1. First install/upgrade the TIBCO Spotfire® Server to version 10.3.

2. Deploy the TIBCO Spotfire® 10.3 distribution on the TIBCO Spotfire® Server 10.3.

3. Start the old version of TIBCO Spotfire® Analyst, log on to the TIBCO Spotfire® Server 10.3 and
accept the update.

With Spotfire 10.3, a trust mechanism for data functions was introduced. Also, the trust stamp was
changed to be calculated with SHA-512. Therefore, when updating from an older version to 10.3 or
later, the trust stamps in all Spotfire analysis files in the library that include IronPython scripts,
JavaScripts, data connection custom queries or data functions must be updated. New server CLI
commands called "find-analysis-scripts" and "trust" can be used to find and update or automatically
trust old scripts and data functions in your library. For more information, see the TIBCO Community
article: https://community.tibco.com/wiki/script-and-data-function-trust-spotfire-103-and-later.

Compatibility Versions

You can use TIBCO Spotfire 10.3 to open .dxp analysis files that were created and saved in any older
version of Spotfire that is still in support.

The compatibility versions of TIBCO Spotfire 10.3 are updated to versions 10.2 and 7.11 LTS. This
means that .dxp analysis files that you create and save in Spotfire 10.3 can be opened in versions 10.2
and 7.11 LTS of Spotfire.

When you use an older version of Spotfire to open an analysis file that was created in a newer version
of Spotfire, features from the newer version might not be available, and the analysis might look and
behave differently compared to the version in which it was created.

Can open version

Version 10.3 10.2 10.1 10.0 7.14 7.13 7.12 7.11 7.10 7.9 7.8

10.3 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

10.2 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

10.1 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

10.0 Yes Yes Yes Yes Yes Yes Yes Yes Yes

7.14 Yes Yes Yes Yes Yes Yes Yes Yes

7.13 Yes Yes Yes Yes Yes Yes Yes

7.12 Yes Yes Yes Yes Yes Yes

7.11 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

7.10 Yes Yes Yes Yes Yes
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7.9 Yes Yes Yes Yes

7.8 Yes Yes Yes
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Third Party Software Updates

The following third party software (TPS) components have been updated or added for version 10.3 of
TIBCO Spotfire® Analyst.

10.3.2

TPS New version

Driver for TIBCO Data
Virtualization

8.1.0
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Closed Issues

The table lists important closed issues in version 10.3 of TIBCO Spotfire® Analyst.

10.3.3

Key Summary

TSDC-5403 This was a known issue in earlier releases of Spotfire 10.3. The issue was closed in version
10.3 HF-9.

The SAP solution for Kerberos single sign-on (SSO) for SAP BW, the Common
Crypto Library (sapcrypto.dll), could not be used for setting up SSO with the
Spotfire connector for SAP BW.

10.3.2

Key Summary

TS-61366 Spotfire sometimes closed unexpectedly during startup, if you used saved login
information that could not be read correctly.

TS-61370 Spotfire sometimes closed unexpectedly when you tried to start it as a restricted
user.

TS-61397 Text areas with filters sometimes caused read errors.

TS-61400 Headers in cross table visualizations were sometimes visible when the width was
set to zero.

TS-61429 For large queries in connections to Salesforce, adding related tables without
selecting a column used in the join resulted in errors.

TSDC-5660 It was not possible to connect to TIBCO Data Virtualization 8.1 with the included
driver for TIBCO Data Virtualization.

TSDC-5854 For large queries in connections to Salesforce, prompts of the type Range and
Manual were case sensitive.

TSDC-5855 For large queries in connections to Salesforce, selecting an empty value in a prompt
resulted in the wrong number of rows being imported.

TSDC-5856 In connections to Salesforce, prompting for empty values resulted in an error.

10.3.0

Key Summary

TSDC-4559 In connections to SAP BW, it was not possible to define a range BEX variable with
the same to and from values.

TSDC-4977 In connections to Salesforce, it was not possible to add custom relations.
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Key Summary

TSDC-5357 There was no license available for controlling user access to the Spotfire Data
Streams connector.

TS-55558 There was no support for text area with large content.

TS-57584 There was no custom header for white-labeling the Spotfire clients (co-branding)
available.

TS-58281 Zoom-out button was not disabled when the map was completely zoomed out.

TS-58721 Preprocessor methods such as $csearch were erroneously included in the list of
available methods when creating transformations.

TS-58770 Cross tables were not filling in custom text for missing data.

TS-58773 It was not possible to access layer properties from the layers control panel.

TS-58791 Radius marking sometimes marked the wrong markers.

TS-58815 It was not possible to import Excel files exported from Microsoft SQL Server
Reporting Services.

TS-58895 Analysis was closed when navigating to a specific page in the analysis after use of
filtering schemes.

TS-59053 Export of prepared reports could take a very long time if the report was set to
repeat pages based on filter values in combination with filtering in analysis.

TS-59125 CRS/Projections list would sometimes load in WMS treeview.

TS-59140 Replacing a data table with an information link that used a parameterized stored
procedure did not work as expected. If invalid values were entered in the first
attempt to replace the data table, it was previously not possible to correct them by
doing a second attempt, using the same information link. This has now been fixed.

TS-59319 There were occasional script errors in an analysis using compatibility versions of
jQuery and jQuery UI.

TS-59628 When Web (OpenID/OAuth2) authentication was used on Spotfire Server, clients
could not login if FIPS compliance was enabled on Windows.

TSS-24583 It was not possible to create information models and links if a duplicate name was
provided more than three times.

SPOT-514 There was a duplicated ISO 3 country code for France in the World Cities
geocoding table.
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Known Issues

The table lists important known issues in version 10.3 of TIBCO Spotfire® Analyst.

Key Summary

TS-53053 No access keys available in the new menu bar and authoring bar.

TSDC-5525 It is not possible to connect to a TIBCO Data Virtualization server (version 8.0 or
later) using plain username/password if the TIBCO Data virtualization server is
configured to use Kerberos for authentication.
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